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Purpose 

This document includes important, late-breaking information about this release of Oracle’s 
Hyperion Reporting and Analysis. Review this information thoroughly before installing. 

Installation Updates 

For information on installation, see the Hyperion Reporting and Analysis Installation Guide for 
Windows and the Hyperion Reporting and Analysis Installation Guide for UNIX. 

Hyperion License Compliance 

Beginning with this release, Hyperion® License Server™ and standalone license files are not 
used for license management. Instead, administrators need to audit product use.  

Administrators need to audit product use for all products, even products that did not previously 
require a license server or standalone license file. If you are updating a product that previously 
used a license server or standalone license file, to ensure compliance with your license 
agreement, you also need to edit a properties file to activate or deactivate features in 
accordance with what you have purchased. 

For more information about license compliance, see the Hyperion License Compliance Readme 
(hyp_license_compliance_readme_921.pdf), which you can find on the Oracle® E-Delivery 
site or the product DVD. 

Note that references to Hyperion License Server may still exist in some of the documentation. 

Supported Upgrade Paths 

If you are upgrading from a previous release, note the following supported upgrade paths:  

9.2.x to 9.2.1 

9.0.1x to 9.2.1 

7.2.5.x, 7.1.5.x, 4.0.5.x, 8.5.x, or 7.1.1.x to 9.2.1 

If you are using a release prior to any of the releases listed above, you must first upgrade to 
one of the releases noted above, and then upgrade to 9.2.1. See the product installation guides 
for upgrade procedures. 

Release 9.2.1 Product Name Changes 

The user interface in Oracle’s Hyperion products has been rebranded for Release 9.2.1 to 
incorporate a new logo, new copyright and trademark information, and new product names. 
Products referred to in this Readme and in the Installation Guide also reflect the current 
product names. However, because the core documentation for Release 9.2.1 has not been 
updated, products are still referred to by their previous names in the documentation. 

Documentation Updates 

References to Hyperion Download Center may still exist in the documentation. Hyperion 
products and documentation are now available on the Oracle Technology Network or the 
Oracle® E-Delivery site. 
 
 

http://edelivery.oracle.com/
http://www.oracle.com/technology/index.html
http://edelivery.oracle.com/
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Known Issues in Release 9.2.1 

Auto-deployment Options in the Hyperion Configuration Utility 

Cannot Auto-deploy WebSphere 6 or WebLogic 9 
On the application server panel in Hyperion Configuration Utility, WebSphere 6 and WebLogic 9 
are displayed as choices for auto-deployment. WebSphere 6 and WebLogic 9 can only be 
deployed manually for this release. Do not select the auto-deployment option for WebSphere 6 
or for WebLogic 9. Follow the instructions in the product installation guide to manually deploy to 
these application server versions. [6589838, 6589839] 

Dashboard Development Services 

Evaluation toolbar tooltips do not display 
Evaluation toolbar tooltips in Dashboard Architect do not display due to UniToolbox limitations. 
[1-218574904] 

Wizard steps are not Unicode enabled 
Dashboard Studio wizard steps on not Unicode enabled. [1-218574924] 

Directory Services 

Properties dialog box does not display owners 
In Workspace Explorer, the owner value is not displayed for files or folders in the Properties 
dialog box. [1-121370645] 

L1 German: Sorting is performed incorrectly according to Name and 
Description 
[1-122207501] 

Edit Permissions dialog box does not show arrows when first accessed in the 
session 
When the Edit Permissions dialog box is first opened, the arrows in the center of the dialog box 
are not displayed. The workaround is to close and re-open the Edit Permissions dialog box. [1-
170699851] 

New Document wizard closes unexpectedly when you do not have permission 
to access Interactive Reporting documents 
When creating Interactive Reporting documents with the New Document wizard, you can select 
a file to which you do not have access (such as a file imported by another user). If you select 
such a file, you get an error message that you do not have permission to access the document, 
and the New Document wizard closes. [1-172449278] 

Objects imported from Shared Services are not displayed until after you 
refresh 
After documents are imported from Shared Services, the documents are not displayed in the 
repository until View > Refresh is selected for the directory containing the imported documents. 
[1-93347204] 
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Financial Reporting 

Charts disappear if the chart title contains an apostrophe 
If you enter a chart title that contains an apostrophe, when you preview the chart, it is no 
longer displayed. The workaround is to not use apostrophes in chart titles. [1-113528100] 

Using the Essbase driver and Advanced Member selection with the NOT 
operator does not work correctly 
When using the native Essbase driver against an Essbase data source, using Advanced Member 
selection with the NOT operator includes members in the NOT condition. This issue does not 
occur when using the EDS/APS driver. [1-14NG86] 

Firefox displays an Error 500 message when a PDF report is run after 
changing the POV 
In Firefox, an intermittent error message is displayed when changing the POV, but the report 
runs successfully. In addition, when scrolling through a report, it may not refresh properly. [1-
175866021] 

Row and Column Templates Column template fails to inherit formats 
When using row and column templates, inherit formatting can only be applied to one axis, 
either rows or columns. [1-201320860] 

Some JSPs fail if path length is greater than 256 characters if installing under 
non-default directory 
Some JSPs fail if the path length is greater than 256 characters. This could happen when 
installing under the non-default directory. It is a known WLS issue, BEA-101190. The 
workaround is to move the directory closer to the root directory to decrease the path length. 
[1-216006001] 

In FireFox, application and database icons do not correctly appear in the 
database connection properties 
The images within the icons are off-center. This does not affect the functionality. [1-
237864041] 

Cannot see Substitution Variables if they contain quotation marks 
Financial Reporting does not recognize surrounding quotes in Essbase Substitution Variables 
(SubVars). If SubVars with surrounding quotes are required for Essbase calc scripts, they must 
be replicated without quotes for Financial Reporting to see them. SubVars can be more easily 
maintained via Essbase MaxL scripts. [1-400012131] 

Text rows do not repeat on the next page via PDF output 
When a text row is inserted below the column dimensions, the text row (row 1) does not repeat 
on any page after page 1. However, column dimension text headings do repeat on all pages. 
This is also true for text columns. If a text column is inserted next to row dimensions and the 
report is more than one page wide, the text column is displayed only on the first page. [3-
24826] 
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Sorting considerations when using auto calculations on multiple dimensions 
Since the outermost layer of an auto calculation is the grand total of all rows in the calculation, 
sorting it is not supported. Sorting on the outermost layer when auto calculations are enabled is 
ignored. In addition, if you have auto calculations on more than one layer and select Sort, you 
must sort on all the heading layers (except the outermost layer) that have auto calculations. 
[3-373014] 

"Suppress if missing" incorrectly suppresses existing data on dynamic 
accounts 
The "Suppress if missing" option incorrectly suppresses existing data on Hyperion Financial 
Management dynamic accounts when the following conditions exist:  

• The POV is set on a dynamic account 

• A custom dimension is in a row with more than nine members selected 

• Only the "Suppress if missing" option is selected 

• Data query optimization is set on data source server  

To workaround this issue, do one of the following: 

• Set data query optimization to the Report server 

• Make sure there are less than nine members selected in the row 

• Instead of using basic suppression options, write advanced options to suppress the missing 
values [3-376086] 

Selecting help from Respond to Prompts screen while previewing a Report or 
a Book with Prompt displays ''Defining Prompts for a Batch'' 
[6535945] 

No prompt for batch level in SAP reports 
[6573796] 

Installation 

Installation fails on UNIX if environment variable values include backslash 
character 
Before running the installation on UNIX, ensure that no environment variables contain a 
backslash character ( \ ) in their values. [1-160425771] 

WebLogic deployment fails on Turkish operating systems 
[1-237420421] 

Cannot use the same installation destination folder when upgrading from 8.x 
to 9.x releases 
The installer does not permit you to choose an 8.x installation folder as the installation folder 
for 9.x; however, if you manually move the vpd.properties file on the computer, the 
installer's check fails, and the installer no longer prevents you from choosing an 8.x installation 
folder. [1-89729701] 
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IIS configuration fails with WebLogic 8.1 and IIS 6 
After you run the configuration tool for the first time and select both "Application Server 
Deployment" and "Web Server" configuration" tasks, the "Web Server Configuration" task fails.  

To fix this: 

1. Edit the following properties file: 

<BIPLUS_HOME>\AppServer\InstalledApps\WebLogic\8.1\httpConfig\iis-
build.properties 

2. Add the line to the end of the file. For example: 

plugin.location=C\:\\bea\\weblogic81\\server\\bin 

Point to the real directory, which contains iisproxy.dll and iisforward.dll. Ensure that 
all backslash ( \ ) symbols are doubled (\\ instead of \ ) and that the colon ( : ) symbol is 
preceded by a single backslash symbol (\: instead of : ) 

3. Restart the configuration tool, and run the "Web Server Configuration" task only.  

For detailed information on IIS manual configuration steps, see "Configuring Microsoft IIS 5/6 
with WebLogic 8/9" in the chapter titled "Manually Deploying into WebLogic 8.1.4" in the  
"Hyperion Reporting and Analysis Installation Guide." [6587345] 

Workspace does not initialize when deployed to Oracle 10g Release 3 Patch 3 
(10.1.3.3.0) 
To work around this, select "Configure Class Loading” in step 3 of workspace.war deployment 
apply the change  and complete the deployment. [6590386] 

Services for Web Analysis and Workspace are not created during 
configuration even though "Install a services" is selected 
To work around this: 

1. Navigate to one of the following directories: 

%BIPlus%\AppServer\InstalledApps\WebLogic\8.1\WebAnalisys  

%BIPlus%\AppServer\InstalledApps\WebLogic\8.1\Workspace 

2. Run installService.bat 

WebSphere Application Server 5.1.1.7 Express X86: ConfigTool does not start 
server1 during deployment and deployment fails 
To work around this, start server1 manually before running the application deployment task  
in the configuration tool. [6623213] 

IIS should be switched to 32-bit compatibility on Windows 2003 64-bit  
Hyperion Reporting and Analysis 9.2.1 supports deployment of its web applications on 32-bit 
versions of application servers on Windows 2003 64-bit. To load a 32-bit version of an 
application server’s plugins, switch IIS to 32-bit compatibility mode before running the 
WebServer Configuration task in the Configuration Utility.  
 
Installation of Session Manager on the same computer as the GSM is desirable. 
Session Manager can be replicated by itself. For optimal load balancing, 
Hyperion recommends that every host include a Session Manager. 
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To switch IIS to 32-bit compatibility: 

1. Open a command prompt and type the following command:  
cscript c:\inetpub\adminscripts\adsutil.vbs SET 
/w3svc/AppPools/Enable32BitAppOnWin64 True  

2. Press Enter and restart IIS. 

After performing these steps you can use the Configuration Utility to automatically configure IIS 
for Hyperion Reporting and Analysis 9.2.1. [6640024] 

The generic version of WebLogic should use the 32-bit version of the JDK on 
Windows 2003 64-bit 
The 64-bit version of the JDK causes EnvLoader to be unavailable for web applications 
(Financial Reporting, Web Analysis) because the 32-bit version of EnvLoader cannot be loaded 
by the 64-bit version of the JDK. [6640118] 

The name shown in the browser's title bar may be incorrect in non-English 
operating systems 
This name can be changed by editing: 

<workspace_web_app>/WEB-INF/conf/BPMServer.properties  

The parameter name is "ApplicationName". For example: 

ApplicationName=HyperionR Workspace  

The name may be incorrect due to the fact that the character after "Hyperion" is supposed to 
be the registered trademark symbol. This character easily gets corrupted when moving from 
one platform to another. [6647639] 

Unable to run SQR job with charts on HPUX (PA-RISC) 
After upgrading from 9.x to 9.2.1.0 on HPUX (PA-RISC), delete the following files from common 
JRE in order to have workable SQR jobs with charts:  

<HYPERION_HOME>/common/JRE/HP/1.4.2/lib/PA_RISC/libmawt.sl  

<HYPERION_HOME>/common/JRE/HP/1.4.2/lib/PA_RISC2.0W/libmawt.sl [6669995] 

JAR files needed for the Web Analysis UI Services Installer 
When using Web Analysis, copy the following JAR files: 

commons-collection.jar  
commons-pool-1.1.jar  

from another HYPERION_HOME/common/SharedServices/9.2.0/lib to: 

WA_HYPERION_HOME/common/SharedServices/lib [6674069] 

Problem with HTTP/AJP ports in the configuration tool when using Tomcat 
When using a Tomcat application server, you must specify an AJP port on the Web Server 
configuration panel. [6674109] 

BIPLUS_1.properties has incorrect db_type_selection 
After upgrading Reporting and Analysis components from 9.2.0.3 to 9.2.1, and before running 
the Configuration Utility, ensure that the DB_TYPE_SELECTION property in 
<HYPERION_HOME>/common/config/product/biplus/9.2.1.0/biplus_1.properties equals:  

DB2 8 or 9: DB_TYPE_SELECTION=0  
MS SQL 2000: DB_TYPE_SELECTION=1  
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MS SQL 2005: DB_TYPE_SELECTION=2  
Oracle 9: DB_TYPE_SELECTION=3  
Oracle 10: DB_TYPE_SELECTION=4 

Note: A potential problem exists for the Oracle 10G database. [6674524] 

When Release 9.2.1 is installed by upgrading any configuration, then ADR is 
set as <false> 
1. Go to //HYPERION_HOME/BIPlus/common/config  

2. Open server.xml  

<property name="IS_ADR_ENABLED">false</property> [6676688] 

Infrastructure 

SQR Production Reporting and generic job file names cannot be defined in a 
different language than in the Operating System where the Job Service 
resides 
Oracle currently supports native file names for SQR Production Reporting and generic jobs in 
the same language as the language settings of the operating system where Job Service is 
deployed. Ensure that your operating system shell default encoding is the same as the default 
file.encoding JVM property for your configuration. [1-115106075] 

Cannot select Smart View as an output option for SQR Production Reporting 
jobs 
For SQR Production Reporting jobs, Ghostscript must be installed and <gshome>/bin must be 
added to the system PATH.  
 
On UNIX, add <GSHome>bin to the PATH in setenv.sh BI+ 
Home>/bin/SQR/Server/dbtype/bin.  
 
On Windows, add <GSHome>bin to the PATH in set_common_env.bat under <BI+ Home>/bin. 
[1-134796551] 

In Firefox, processing an Interactive Reporting document after the session 
expires prompts users to log on, despite specifying credentials 
If you encounter this issue, save the Interactive Reporting document to a disk and then reopen 
it. [1-167378933] 

Single sign-on to Financial Management from a Workspace URL prompts with 
login page 
When attempting to launch Financial Management with single sign-on from a Workspace URL, 
users are prompted with a login page instead of being directed to the Financial Management 
Workspace without prompting. 
  
The workaround is to URL encode the parameter value to extUrl (extRedirectForm.html). To do 
so, load an HTML page and redirect to the extRedirect command, using a form to post extUrl to 
extRedirect cmd:  

<html>  
<body onload="document.forms[0].submit();">  
<form method=post action="http://sprig:19000/workspace/browse/extRedirect">  
<input type=hidden name=extUrl value="http://reports-
js/hfm/Logon/HsvLogon.asp?sso_token=$SSO_TOKEN$">  
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</form>  
</body>  
</html> [1-180623171] 

Icon with non-English characters in its name is not displayed for mime type 
Japanese character set packages need to be installed on UNIX systems in order to upload icon 
files with Japanese characters in the name. Each system’s installation guide contains 
information concerning additional steps (packages to add) to make Japanese characters 
available. [1-211500841] 

An empty page is displayed after opening an Interactive Reporting document 
from generic job output 
If an empty page is displayed when opening an Interactive Reporting document from generic 
job output or a BQD from Product Reporting output, verify that the latest version of Interactive 
Reporting Web Client is installed, and retry. [1-242072367] 

Unable to run Production Reporting jobs with parameters after upgrading 
After upgrading, ensure that AutoDetectUnicodeFiles=true in SQR.INI. This value is set to 
true for clean installations, but old installations could have settings that differ. See the 
documentation on the ENCODING-FILE-INPUT Job Service parameter for more details. [1-
250250871] 

Open and Save dialog boxes are not accessible when using WebSphere 5.0.2 
on Windows 2003 
Compilation of JSPs at runtime may fail for some class files on WebSphere Application Server 
5.0.2. If the error message displayed is "error 500 failed to compile SomeFilename.JSP," look in 
the WebSphere server's temp directory for a .class file of the same name and delete it. Close 
the browser, log in, and try the offending UI operation again to force the recompile of the failed 
JSP/class file. [1-126574150] 

Unable to reset information in Workspace Administer 
You may encounter problems when resetting values in one or more Administer areas. To work 
around this, cancel the action and start again. [1-275057633] 

Field validation incorrectly occurs when selecting the Cancel button on the 
Run Job page  
To work around this issue, enter dummy values to satisfy the validations. [1-128575793] 

Interactive Reporting 

Mandatory ExporttoStream arguments are shown as being optional in script 
editor description 
The Interactive Reporting script editor description pane incorrectly indicates that all arguments 
for the ExportTotSteream method are optional. These three arguments are mandatory and 
must be supplied in order for ExportToStream to function: Filename, format, and 
datastreaming. [1-106400589] 
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In Workspace, some Computed Item names do not display correctly in Data 
Layout 
Special characters that are not allowed in naming JavaScript's identifier or functions must not 
be used in column names and control names. For instance, whitespaces, "|", "$", € (euro), 
reverse solidus (backslash) (same as half-width Yen & half-width Won).  
Using such characters in control names is not supported, and can cause document rendering 
useless in Workspace. [1-117056011] 

Embedded content, help, and dialog limitations 
Limitations of Interactive Reporting document files (BQYs) that are embedded in a dashboard 
through the Embedded Browser or Hyperlink controls include:  

• Help is not available in toolbar or dialogs  

• Number Formatting option is not available  

• References subdialog of Computed Item dialog box is not available  

The same limitations apply when an Interactive Reporting document file is referenced by a 
SmartCut URL that uses the get action (rather than get_withnav). [1-121202823] 

ActiveSection OnActivate/DeActivate events fire when changing a different 
section's name 
[1-124907511] 

Interactive Reporting locale preference date formats do not change until next 
session 
Changes to locale preferences do not take effect until the user session is ended and restarted. 
[1-128991630] 

Cannot drag and drop locally saved Interactive Reporting document files that 
differ to the same browser when running Interactive Reporting Web Client in 
Firefox 
You must log off and log on again for the new version to be used. [1-168267494] 

In Workspace, switching from CustomValues to ShowValues filter in a Query 
section causes the browser to hang 
If the dialog box becomes inactive, click somewhere on the borders (area outside of the filters 
area) to reactivate it. [1-171501191] 

Printout method does not execute in documents that contain Alert after 
Printout() 
Use of the Alert method after the Printout() method prevents the Printout method from 
executing in Workspace. [1-172133795] 

CTLib/Sybase connection is not supported by Interactive Reporting 
CTLib is not supported due to insufficient Unicode support. Use an ODBC connection using 
supplied Data Direct ODBC drivers.  [1-179915581] 
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PreloadContent() method improperly activates section, mismatches 
Dashboard and Catalog sections 
When using the PreloadContent object model method:  

• Invoke preloadContent only after the URLs of the embedded browsers are determined.  

• All embedded browsers of the pre-loaded Dashboard are displayed even before that 
Dashboard is activated.  

• Invoke preloadContent only for a single Dashboard that users visit. This is recommended 
to avoid overloading the browser, which could cause the negative performance [1-
213080681] 

Exceptions occur in Workspace when processing local results or a derived 
query when the source query is removed 
In Workspace, deleting the main query section before switching to the derived query section 
may not clear the Request column items of the derived query. This is due to the "Partial 
document loading" feature. The workaround is to switch to the derived query section before 
deleting the main query section. [1-213453921] 

Using a Euro or other special characters in control names for the onClient 
script causes a JavaScript error in Workspace 
Dashboard control names must not contain these characters: %,#,&,*,!,€,\,/ [1-218463891] 

Report section XLS export does not check whether the destination file is 
locked and export fails 
Report section XLS export to an existing file does not check whether the destination file (which 
should be overwritten) is locked. XLS export does not occur in this case although the user is 
asked about file replacement. This is not an issue for Results or Table sections.  [1-227444990] 

Interactive Reporting services cannot be started on AIX 
This AIX patch (for both 5.2 and 5.3) is a prerequisite for Interactive Reporting services: 
November 2005 XL C/C++ Enterprise Edition V7.0 for AIX PTF. See http://www-
1.ibm.com/support/docview.wss?uid=swg24011025. [1-227641714] 

TCResults: Unable to add computed item via speed menu in Workspace if 
Query Results were not saved with an Interactive Reporting document file 
To add computed items, select Actions > Add Computed Item. [1-229059219] 

TCOMGeneral - ExportToStream fails with special characters in target doc 
name 
Do not use special characters in the target name. [1-241300831] 

Firefox error occurs when turning on Data Layout in Workspace 
When using FireFox 1.0.7, the error "BqHdl.handleRequest fails: 
content.BI_postHandleRequest is not a function" is displayed when you attempt to turn 
on Data Layout for Results, Table, Pivot, or Chart sections in Workspace. You get this error only 
once in a Workspace session. [1-242597311] 

Interactive Reporting cannot connect to Red Brick on UNIX 
Red Brick is supported only on Windows for this release. [1-247297871] 
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BQYs cannot be processed in the Interactive Reporting Web Client if users log 
into the Avalanche server after the session has expired 
Close the BQY and re-open it to proceed. [1-248254893] 

Korean and Chinese custom date-and-time formats (beginning with [$-F400] 
or [$-412] are not supported for import 
Several custom Korean and Traditional Chinese date-and-time formats (beginning with [$-
F400] or [$-412]) are not supported and do not import correctly from Excel. (AM/PM part is not 
displayed with hieroglyphs as it does in the original Excel file.)  

Problem formats include:  

Korean:  
[$-F400]h:mm:ss AM/PM  
[$-412]AM/PM h:mm;@  
[$-412]AM/PM h:mm:ss;@  
[$-412]yyyy"-"m"-"d AM/PM h:mm;@  
[$-412]AM/PM h"•" mm"•";@  
[$-412]yy"-"m"-"d AM/PM h:mm;@  
 
Chinese (Traditional):  
[$-F400]h:mm:ss AM/PM  

The above formats are available under the Time/Date category in Excel like standard formats 
but are custom formats [1-250056731] 

For ODBC/Teradata connections on Solaris, an error is displayed when 
entering correct login information after invalid login information 
When using version 4.0 of the Teradata ODBC drivers on UNIX platforms, make sure that 
CharacterSet=UTF16 is present under the data source in odbc.ini. [1-250538592] 

Sybase IQ is not supported on UNIX 
ODBC Drivers must support UTF16. Sybase IQ ODBC driver does not support UTF16 on UNIX. 
Hyperion Interactive Reporting Data Access Service must be used on Windows for Sybase IQ 
data sources. [1-262593101] 

In Firefox, you cannot open a locally saved Interactive Reporting document 
file that contains double-byte characters in its file name 
Firefox does not invoke Interactive Reporting Web Client if the file name contains characters 
from a code page that differs from the system code page. You cannot use multi-lingual file 
names in Firefox. The file names must match the system code page. [1-264647661] 

Header/footer is mapped to the dialog box font, but PDF export lacks double-
byte characters 
By default, headers and footers of Results, Table, Pivot, and Chart sections are mapped to the 
dialog box font MS Sans. Because this font is not presented as a single file in the system, but 
as a series of fonts that may be used to show specific characters, the PDFLib can export only 
certain amounts of characters using the new export mechanism for multicode page PDF export. 

To avoid the lack of double-byte characters in PDF export, change the Header/Footer font to 
Arial Unicode MS or Andale WT.  [1-266728601] 
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Inserting a new query in Interactive Reporting Web Client may cause an 
invalid logon error 
Try processing again as a workaround. This issue does not happen if database credentials are 
provided in the database connection file or Query section. [1-274236113] 

Access 97 MDB files should be converted to Access 2003 format 
Access 97 is non-Unicode and should be converted to an Access 2003 format when used as a 
data source for Interactive Reporting. [1-293557831] 

Cannot connect to a database using an Open Client/Sybase connection on 
Solaris due to missing locales  
Configure Sybase client locales to include the following: 

For Solaris and AIX: en_US.ISO88591  

For HPUX and Linux: en_US.ISO88591  

Sybase Client locales are in <Sybase Client Install Dir>/locales/locales.dat. [1-
95958211] 

When used with Workspace, the Internet Explorer 7 browser crashes after 
several BQY or OCE documents have been imported 
If you import eight to ten BQY or OCE documents into Workspace in one session, the Microsoft 
Internet Explorer 7.0.5730.11 web browser might crash. To resume your work, re-launch the 
web browser. [6655514] 

Cannot install Insight through HTTPS when using IBM HTTP Server 
2.0.47.1+SSL and WebSphere 5.1.1.7  
OCI (one click installer) fails with error code 6004. If SSL is needed on the web server, use IHS 
1.3.28, which is bundled with the WAS 5.1 installer. [6658624] 

Dashboard section help file missing in the 9.2.1 installation of Designer 
When you open a Dashboard section and press F1 or select Help > Help on Content, an error 
occurs indicating that the system cannot find the file. [6661999] 

Export to PDF of Pivot section cuts off right edges 
The issue is that the total side label width is wider than the Portrait settings. Reduce the 
number of side labels to decrease the width or change the page setup to Landscape and then 
export to PDF. [8-511893124] 

Migration 

During migration, the error message COMMON_SessionNotExists:0 is 
displayed intermittently 
If you receive this error, restart the Migration Utility and continue. [1-168899341] 

HPSu Owner for shortcuts and folders is not migrated 
For migration from HPSu, ownership information is not migrated for shortcuts and folders. [1-
170782011] 
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When migrating Hyperion Analyzer content, cannot connect to target DB2 8.2 
database using native JDBC drivers when source database is DB2 7.x 
Cannot connect to target DB28.2 database using native JDBC drivers when the source database 
is DB2 7.x. These JDBC drivers are supported for migration from DB2 7.x to DB2 8.y:  

• Source DB2 7.x db2java.zip type 2 driver > target DB2 8.y Hyperion supplied DD driver  

• Source DB2 7.x db2java.zip type 2 driver > target DB2 8.y db2jcc.jar type 4 driver [1-
176763528] 

Inconsistent results when using JDBC versus Host and Name migration 
methods 
You must use the latest Oracle 9.2.0.5 JDBC driver for the target Oracle9i repository. [1-
238593420] 

User's home folders are not synchronized with user preferences when the 
user name contains unsupported characters 
If a migrated user name contains unsupported symbols and is not synchronized with the user's 
home folder, copy the previous user's home folder content to the migrated user's home folder. 
[1-245569867] 

Circular dependencies checker works incorrectly when Portal is configured to 
use an external authentication system 
Circular dependency checker works incorrectly with external authentication systems. Remove 
circular group dependencies in your external authentication system before running the 
migration. [1-279242031] 

ActiveDocument.Sections formatting is lost in Text labels when migrating 
from Release 6 to System 9 
Text labels with ''ActiveDocument.Sections" do not retain formatting when migrating from v6 to 
Hyperion System 9. [8-529107952] 

Migration Utility fails when Usage Tracking tables are in a different schema 
from the Repository 
Migration from HPSu fails if source Usage Tracking tables are in a different schema from the 
Repository. Before migration, manually create and fill the Usage Tracking tables using the SQL-
scripts supplied with the HPSu installation. [8-535630014] 

Users/Groups with custom permissions get Global Admin role during 
migration 
During Web Analysis 7.2.x migration, user/group provisioning is performed incorrectly if custom 
permissions are used instead of pre-defined roles at the source system. Review role 
assignments policies after migration to remove extra roles given to users or groups. [6630820] 

Apply owner on <user>/profiles folder as well as on user home folder 
Users with 'Information Consumer' and 'Interactive User' roles migrated from Web Analysis 
7.0.x will not be able to edit their preferences after migration.  

To fix this, run the following 2 SQL scripts against the target database after migration:  

Script 1: 

UPDATE sts0035_cnd622.V8_RESOURCE_OWNER  
 SET owner_id = USERS.target_id  
FROM          
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sts0035_cnd622.V8_RESOURCE_OWNER  
       JOIN  
(sts0035_cnd622.V8_EXTERN_USER USERS  
       JOIN  
             sts0035_cnd622.V8_CONTAINER USER_HOME_FOLDER  
             on    USER_HOME_FOLDER.name = USERS.css_login_name  
       JOIN sts0035_cnd622.V8_CONTAINER ROOT_FOLDERS  
             ON  
USER_HOME_FOLDER.parent_folder_uuid=ROOT_FOLDERS.container_uuid  
                         and ROOT_FOLDERS.name = 'Users'  
                         and ROOT_FOLDERS.parent_folder_uuid = 'REPORTMART'  
       JOIN sts0035_cnd622.V8_CONTAINER ALL_PROFILE_FOLDERS  
             ON USER_HOME_FOLDER.container_uuid =  
ALL_PROFILE_FOLDERS.parent_folder_uuid  
                         AND ALL_PROFILE_FOLDERS.name = 'Profiles'  
       ) ON  
sts0035_cnd622.V8_RESOURCE_OWNER.resource_id=ALL_PROFILE_FOLDERS.container_uuid  
AND USERS.migration_label LIKE 'HYA_7_0_%'  
.  

Script 2: 

UPDATE sts0035_cnd622.V8_RESOURCE_OWNER  
  SET owner_id = USERS.target_id  
FROM          
sts0035_cnd622.V8_RESOURCE_OWNER  
       JOIN  
(sts0035_cnd622.V8_EXTERN_USER USERS  
       JOIN  
             sts0035_cnd622.V8_CONTAINER USER_HOME_FOLDER  
             on    USER_HOME_FOLDER.name = USERS.css_login_name  
       JOIN sts0035_cnd622.V8_CONTAINER ROOT_FOLDERS  
             ON  
USER_HOME_FOLDER.parent_folder_uuid=ROOT_FOLDERS.container_uuid  
                         and ROOT_FOLDERS.name = 'Users'  
                         and ROOT_FOLDERS.parent_folder_uuid = 'REPORTMART'  
       JOIN sts0035_cnd622.V8_CONTAINER ALL_PROFILE_FOLDERS  
             ON USER_HOME_FOLDER.container_uuid =  
ALL_PROFILE_FOLDERS.parent_folder_uuid  
                         AND ALL_PROFILE_FOLDERS.name = 'Profiles'  
       JOIN sts0035_cnd622.V8_CONTAINER ALL_ANALYZER_PREFERENCES_FOLDERS  
             ON ALL_PROFILE_FOLDERS.container_uuid =  
ALL_ANALYZER_PREFERENCES_FOLDERS.parent_folder_uuid  
                   and ALL_ANALYZER_PREFERENCES_FOLDERS.name = 
'Analyzer Preferences'  
       ) ON  
sts0035_cnd622.V8_RESOURCE_OWNER.resource_id=ALL_ANALYZER_PREFERENCES_FOLDERS.con
tainer_uuid  
AND USERS.migration_label LIKE 'HYA_7_0_%' [6612522] 

Performance Scorecard 

A Run Time Error message is displayed when the Notes symbol is selected in 
localized versions of Performance Scorecard Release 9.2.x 
The error is displayed in all localized releases of Performance Scorecard 9.2.x in the popup 
Scorecard details window (accessed by clicking the map element). This problem is fixed in 
Release 9.3 where the popup window has been changed to a Windows popup. [8-516025842] 
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SAP BW 

$HYPERION_HOME/BIPluscommon/SAP/bin/explodejar must be run as part 
of the Web Analysis configuration process for SAP BW connectivity 
[1-266682541] 

Export to Excel as "query-ready" is not allowed for SAP reports 
SAP BW reports exported in "query ready" format to Excel cannot be queried in Excel, because 
Smart View does not currently support SAP BW as a data source. [1-14KS2V] 

Web Analysis 

Refresh button in Workspace for Web Analysis content does not prompt to 
save changes before reloading 
Opening a Web Analysis document in Workspace and clicking the Refresh button (either from 
the toolbar or the View menu) reloads the document without prompting you to save if the 
document was changed (for example, drilling or member selections). [1-177578560] 

API has samples and documentation from Hyperion Analyzer 7.x 
Web Analysis Studio client API documentation and samples from Hyperion Analyzer 7.2.x still 
apply to Hyperion System 9. Please contact Hyperion Customer Support for the 7.2.x samples 
and documentation. This will be addressed in a future release. [1-235514371] 

Servers may be displayed as "null" in the Related Content dialog box 
The Add Related Content dialog box in Web Analysis Studio may display the Reporting and 
Analysis node in the Available list as "null on host:19000" instead of "Reporting and Analysis on 
host:19000" where host:19000 is the name and port number of a Reporting and Analysis 
server. [1-466501965] 

Unable to see related content entries in Web Analysis Studio 
To enable Related Content in Web Analysis:  

1. Ensure that Workspace is running.  

2. Open the Web Analysis properties file: 
/BI PLUS/InstalledApps/config/WebAnalysis.properties 

3. Uncomment and fill in the following lines: 

######################### SHARED SERVICES CONFIG######################  
#Shared.Global.Conn.UserName=admin  
#Shared.Global.Conn.Password=password  
#Shared.Global.Conn.HostName=localhost  
#Shared.Global.Conn.Port=58080  
#Shared.Global.Conn.password-encrypted=false 

Shared.Global.Conn.UserName - username of Shared Services Administrator  
Shared.Global.Conn.Password - password of Shared Services Administrator  
Shared.Global.Conn.HostName - Shared Services host  
Shared.Global.Conn.Port - Shared Services port  
Shared.Global.Conn.password-encrypted - is password of Shared Services 
Administrator encrypted  
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4. Register the related content server for a particular application by uncommenting and filling 
in the following lines:  

######################### RELATED CONTENT CONFIG #####################  
#RelatedContent.Server.Name.0=local  
#RelatedContent.Server.Description.0=Hyperion System 9 BI+ On Localhost  
#RelatedContent.Server.URL.0=/workspace/browse/listXML?&sso_token=$SSO_TOKEN$  

#RelatedContent.Server.Version.0=1.2.0 #RelatedContent.Alias.Name.0=local  
#RelatedContent.Alias.Protocol.0=http  
#RelatedContent.Alias.HostName.0=localhost  
#RelatedContent.Alias.Port.0=19000 

RelatedContent.Server.Name.0 - is the string value that is displayed in the 
Add Related Content dialog box.  
RelatedContent.Server.URL - is the uniform resource locator used to launch the 
integrated Hyperion application.  
RelatedContent.Alias.HostName.0 - host name for integrated Hyperion 
application.  
RelatedContent.Alias.Port.0=19000 - port name for integrated Hyperion 
application.  
RelatedContent.Alias.Name.0 - is used to bind RelatedContent.Server.* 
properties to corresponding RelatedContent.Alias.* properties.  

The TargetURL must be in the following format:  

http://<hostname:port>/<webAppURL>?<Application-specific parameters> 

The application-specific parameters are defined by individual integrated applications.  

Note that replacement tags are used within the application-specific parameters so that user 
authentication information can be passed in a consistent way. The replacement tag for Web 
Analysis is $SSO_TOKEN$. 

5. Encrypt Shared.Global.Conn.Password by running one of the following: 
/BI PLUS/InstalledApps/config/EncryptPasswordUtil.bat 
/BI PLUS/InstalledApps/config/EncryptPasswordUtil.sh  

6. Update WebAnalysis.properties and restart the Web Analysis server. [1-224734591] 

Web Analysis is not fully functional in WebSphere cluster 
If you are installing Web Analysis on a WebSphere or WebLogic cluster, and Reporting and 
Analysis paths differ on some of the cluster nodes, perform the following actions before 
deploying the Web application cluster:  

1. Place WebAnalysis.properties in the same paths on all cluster nodes. 

For example /etc/ on UNIX or C:\Program Files\Common Files on Windows.  

2. Modify web.xml in:  
<BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>/WebAnalysis/applications/WebA
nalysis.ear 

On Windows: 

a. Select Start > Run, type cmd, and enter the following: 
 > set PATH=<JDK_PATH>\bin•%PATH% 
 > mkdir "%TEMP%\watmp" 
 > cd "%TEMP%\watmp" 
 > jar xf C:\832sp4\WebAnalysis.ear WebAnalysis.war 
 > jar xf WebAnalysis.war WEBINF\web.xml 
 > notepad WEBINF\web.xml 

b. In Notepad, press Ctrl+H to open the Replace dialog box. 
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c. In Find What, enter <BI+_HOME>\InstallableApps\config. 

d. In Replace With, enter a path from Step 1. 

e. Click Replace All. 

f. Save web.xml and close Notepad. 

g. At the command line, enter the following: 
 > jar uf WebAnalysis.war WEBINF\web.xml 
 > jar uf jar uf C:\832sp4\WebAnalysis.ear WebAnalysis.war 

h. After last command runs, deploy the following to your cluster: 
<BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>/ 
WebAnalysis/applications/WebAnalysis.ear  

 On UNIX: 

a. At the command line, enter the following: 
 > PATH=/usr/java14/bin:$PATH 
 > mkdir /tmp/watmp 
 > cd /tmp/watmp/ 
 > jar xf BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>    
/WebAnalysis/applications/WebAnalysis.ear WebAnalysis.war 
> jar xf WebAnalysis.war WEBINF/web.xml 
> sed 's/<BI+_HOME>\/InstallableApps\/config\ 
//<WEBANALYSIS_PRTOPERTIES_LOCATION>/g' WEBINF/ web.xml >/tmp/$$ && mv 
/tmp/$$ WEBINF/web.xml 
<WEBANALYSIS_PRTOPERTIES_LOCATION> is path from step 1 
Note that you must quote all slashes with a backslash in paths for this 
command. For example, \/home\/hyperion\/ biplus\/InstallableApps\/config 
> jar uf WebAnalysis.war WEBINF/web.xml 
> jar uf <BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION> 
/WebAnalysis/applications/ WebAnalysis.ear WebAnalysis.war 

b. After the last command runs, deploy the following to your cluster: 
<BI+_HOME>/InstalledApps/<AS_NAME>/<AS_VERSION>/ 
WebAnalysis/applications/WebAnalysis.ear [1-240670251] 

When using Smart View, may need to use Refresh All to retrieve the desired 
PowerPoint document 
When selecting the second or subsequent report to be refreshed in PowerPoint, the first report 
may be refreshed instead. It may be necessary to use Refresh All in order to refresh the desired 
report in PowerPoint. [6625953] 

POV from previous Financial Reporting documents is returned when launching 
Related Content from Web Analysis to Financial Reporting 
[6643802] 

BQYs opened via HTML links from Web Analysis documents do not inherit POV 
[6650001] 

Web Analysis does not support browser plug-in JVM 1.3.x   

Related Content does not function if the session is inactive for 30 minutes 
To change the session timeout in Web Analysis, set the atf.sessionscope.timeout Java 
system property. The default value of this property is 20 minutes. You must synchronize this 
value with the values for HttpSession (see <web app name>\WEB_INF\web.xml for 
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application) and bpm framework (see workspace\conf\subcontext.properties). [8-
521867635] 

Workspace User Interface and Navigation 

Specifying a default language in Workspace 
Workspace can be forced to display the user interface in a particular supported language. For 
example, to show the user interface in German (language code of "de") only, edit: 

<workspace_web_application>/WEB-INF/conf/BpmServer.properties  

and change:  

SupportedLocales=en,de,es,fr,it,ja,ko,nl,pt,ru,tr,zh,zh_TW  
DefaultLocale=en  

to:  

SupportedLocales=de  
DefaultLocale=de [6656316] 

The system intermittently hangs and displays an error message when opening 
a folder after logging in 
When using the Windows operating system, the Hyperion System 9 browser and server 
components should not be run on one computer. If both components must be run on one 
machine for development or demonstrations, however, you must set Windows system 
performance options to optimize applications, not background services.  

To set Performance options, open the Windows Control Panel and select System > Advanced > 
Performance Options. [1-118004070] 

Date and time formats in drop-down date selectors are displayed incorrectly 
Throughout Workspace, there are many date and time selectors that do not use a popup 
calendar. Instead, they are made up of dropdowns for month, day, year, hour, minute, AM/PM. 
Depending on the locale, the order of these items may differ from the US order. For example, in 
Korean, the correct order is:  

[Year] [Month] [Day] [AM/PM] [Hour] [Minutes]  

Many dates also display incorrectly using the US format mask mmmddyyyy, instead of being 
displayed in the current locale format.  

Date formatting in Workspace (for date selectors and static labels) is defined by parameters in 
ServletConfigurator. That means you could manually set up any formatting you want (and this 
formatting would be applied everywhere in workspace), but at the same time formatting is no 
longer depend on locale settings. [1-145223858] 

When a text field is selected in Firefox, the cursor does not display 
When using Firefox, the cursor does not display in some text boxes. One example is the text 
box in the dialog box that opens when the user renames a file or folder. This problem has been 
traced to Mozilla bug 167801. [1-151162889] 

SQR Production Reporting jobs in Excel/Word/PPT output open outside the 
Firefox framework 
When using Firefox, documents in common spreadsheets and word processing formats open in 
a separate window; they are not embedded in the browser as when using Microsoft Internet 
Explorer. [1-171197362] 
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Firefox 1.5.0.1 crashes when launching Reporting and Analysis 
Firefox 1.5.0.1 does not work with this release of Reporting and Analysis due to a problem with 
Firefox's JavaScript interpreter. See: 

https://bugzilla.mozilla.org/show_bug.cgi?id=325540 

This problem is corrected starting in Mozilla Firefox 1.5.0.2. [1-203592811] 

Group preferences are not enforced for newly added users 
Group preferences are applied only to current group members, not to users who are added to 
the group after the group preferences are set. [1-217326076] 

Logging on to Reporting and Analysis using 
http://server:19000/workspace/index.jsp gives JavaScript errors on Oracle 
Application Server 
Reporting and Analysis on Oracle Application Servers does not allow logon using URLs in the 
form: 

http://server:19000/workspace/index.jsp  

One workaround is to omit index.jsp from the URL. For example: 

http://<server>:<port>/workspace/  

Another workaround is to use the fully-qualified hostname in the URL. For example: 

http://server.domain.com:19000/workspace/  [1-224006021] 

Arrows used to move users when assigning Shared Services preferences are 
missing on initial page access 
Images are visible after you log off and log in again, and when you resize the window. [1-
237576241] 

After changing font size, unable to select correct objects in Workspace 
[8-609661541] 

Some menu items may not be visible in Internet Explorer 7 
In order for menus to size and position properly, go to the Internet Security Zone Advanced 
settings and select Allow script-initiated windows without size or position constraints. 
[8-614839821] 

May fail to obtain items using SmartCuts if an item name contains double-byte 
chars 
To solve problems with the WebLogic connector, add WLForwardUriUnparsed ON to: 

%HYPERION_HOME%/common/httpServers/Apache/conf/HYSL-WebLogic.conf 

The content should appear as:  
...  
LoadModule weblogic_module modules/mod_wl_20.so  
WLForwardUriUnparsed ON  
...  [6643278] 

iHTML BQY job output does not appear if bqtype=iHTML is specified in a 
SmartCut 
[6643904] 
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Defects Fixed in Release 9.2.1 

Financial Reporting 

Request Description 
8-537155661 Add Hyperion Financial Management 9.2.0.x as a runtime client 

in the Installation Guide. 

8-566896846 Equivalent prompts should merge by column in a Book if defaults 
are set differently for each column. 

8-590584401 "-0" or "$0.00" sign when exporting PDF to Excel. 

8-610414813 Client would like Financial Reporting not to have to write in the 
registry especially for users. 

8-613303985 'Merge' symptom when opening Report containing Row Template 
in Studio. 

8-639547411 Responding to Prompts - Selection/de-selection changes 
members in choice list to Expandable Form. 

8-644009647 Error when changing database connection of Financial Reporting 
report when renaming report with a comma included. 

Infrastructure 

Request Description 
8-598953661 Every 7th or 8th Chinese character in email body is replaced by 

junk "=" character. 

8-612622637 Concurrent usage of SDK API Job.getProgramOutputs() causing 
100% CPU on repository. 

8-631628941 The properties set/retrieved in the SDK seem irrelevant to what 
is happening with the user. 

8-641389798 When using pie charts with JAWS, the spacebar command 
performs incorrectly. 

8-644593013 Consolidated Job Status reports successful job execution even 
though 'save document' fails. 

8-645114281 SSO_TOKEN from HPSu does not get recognized by Hreports, 
and user login fails with a blank screen 

8-645114512 Recurring time event set for two weeks or four weeks switches to 
10 days upon refresh. 

8-645114555 Original file name is not changed when replacing a BQY job. 

8-645114588 *.inc files containing code should not be downloadable from 
Workspace.  

8-659509075 When running a job with multiple cycles, only the last cycle 
produces output. 
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Interactive Reporting 

Request Description 
8-610783325 Values does not get filtered correctly using Interactive Reporting 

Studio V9.2.0.3 "Show Values" functionality. 

8-612398311 When using System 9 Interactive Reporting V9.2.0.x with 
IIS/Tomcat, the Interactive Reporting plugin process is not 
working when using hostname. 

8-614671959 Browser crashes when closing a BQY with an embedded browser 
pointing to an object on System 9. 

8-614793872 Insight IE browser gets shutdown if changing a dashboard 
section to be a design mode. 

8-621152798 A similar problem with CR 1-179391322 happens using V9.2.0.x 
Interactive Reporting Studio. 

8-632556353 When logging into Windows with a different user, the Interactive 
Reporting Studio Client menu get displayed in English. 

8-641783458 Error: "An unknown error has occurred. Please save your 
document and restart your application." 

8-642275471 When importing data from a file, duplicate column names get 
changed differently from the prior release. 

8-642464271 BIService is running more jobs than specified in server.xml. 
Count of concurrent jobs is wrong 

8-644196887 When using the HPSU 8.5 Japanese iHTML client, a message get 
displayed in English. 

8-644408781 In Designer Chart section, wrong "Label Item" gets displayed and 
no records are retrieved. 

8-644593128 Incorrect character displayed in job notification email body. 

8-644593170 Using a relative path to export report sections to PDF via script 
no longer works in iHTML. 

8-648436151 Usage Tracking is not populating Object Name and Path for BQY 
job outputs open in the Interactive Reporting plugin. 

8-648478781 Computed items are not evaluated correctly the first time a 
migrated document is processed. 

8-649729401 Oracle Error when processing Interactive Reporting Web Client 
results in Firefox installed on a German Windows XP. 

8-651180076 Expired certificate issued when exporting results to Excel from 
Workspace. 

8-653191162 Tables are not joining correctly when using a server-defined join 
in Explorer. 

8-654728799 Typing a "d" in a textbox in a dashboard causes the dashboard to 
switch to design mode in German Interactive Reporting Studio. 

8-659988521 Several production jobs crash the BIService after upgrading to 
9.2.0.3. 
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Performance Scorecard 

Request Description 
8-532859084 Cluster fails to register with Shared Services. 

8-593600191 Cannot open attachments with Korean name in initiative tab. 

8-619562931 Adding a Domain parent to itself causes an error 

User Provisioning 

Request Description 
8-661258411 SSO token login, does not allow connecting to Essbase for user 

preferences. 

Web Analysis 

Request Description 
8-608859794 Export to Excel returns unexpected results with Italian locale. 

8-621093994 Analysis tools > Calculation window does not appear with Turkish 
locale. 

8-642883779 Calculation of Function "percent of a constant value" does not 
work. 

8-607592080 Sort for some members does not work under HTML. 

8-644864726 Database formatting is not consistent. 

8-661258231 Extend URL character maximum to 256 versus current of 80 in 
"Launch External Browser" 

8-661258328 Dropdowns not active in Workspace 9.2. Select member from 
dropdown and nothing happens. 

8-661486562 Client wants to have a new dimension selecting filters feature. 

8-661486605 Web Analysis Analyzer API Client Test Console Hangs. 

8-661486688 Combo Box w/ subset does not fully function in Workspace. With 
drop down of three members, you can only see two. 

8-661486719 For multiple selection button subscription controls, stronger 
visual to show selected member button. 

8-661486944 Web Analysis malfunctions while using a query that retrieves a 
large number of records from Essbase. 

8-661773329 Reports do not respect the size of the HTML window, and need to 
be resized manually. 

8-661773407 If a parent has special character ( ' ) when creating a relational 
connection, no data is returned. 
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